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1 Introduction 

The MIRA 3 series is a family of high-quality; fully PC-controlled scanning electron 

microscopes equipped with a Schottky Field Emission electron gun designed for high vacuum 

or variable pressure operations. 

The most important features of the microscope are: 

 High brightness Schottky emitter for high-resolution / high-current / low-noise 

imaging. 

 Unique three-lens Wide Field OpticsTM design offering the variety of working and 

displaying modes embodying the Tescan proprietary Intermediate Lens for the beam 

aperture optimization. 

 Real time In-Flight Beam TracingTM for the performance and spot optimization 

integrating the well established software Electron Optical Design. 

 A powerful In-Beam detector of secondary electrons located in the objective lens 

enabling work at very short working distances for high resolution. 

 Fast imaging rate. 

 High-throughput large-area automation, e.g., automated particle location and 

analysis. 

 Fully automated microscope set-up including electron optics set-up and alignment. 

 Sophisticated software for SEM control, image acquisition, archiving, processing and 

analysis. 

 Network operations and built-in remote access/diagnostics. 

This manual provides an overview of the components, the operational principles and the use 

of MIRA 3 scanning electron microscopes. Not all parts of this manual may apply to a given 

installation nor should be taken laterally in all cases. Details of the MiraTC software may also 

vary according to the actual setting and thereby differ slightly from what is shown in the 

figures. 

Since MIRA 3 is installed and maintained by trained specialists, technical details and 

installation procedures are limited to a short overview. In case of necessary maintenance, 

reinstallation, hardware changes, etc. the appropriate service authorities or your local 

supplier must be contacted for further assistance and instructions. 
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2 Safety Information 

The microscope is equipped with an uninterruptible power supply (UPS). The following steps 

are necessary to remove voltage from all the parts of the microscope: 

1. Unplug the mains power cord of the UPS from the mains socket. 

2. Switch the mains switch of the UPS to the off position. 

Only a service engineer can perform operations with the microscope mains switch, UPS 

mains power cord or UPS mains switch. 

The user is liable to make himself familiar with the care of the device and with the safety 

rules valid in the country of the user. The microscope works with electric voltages that can 

be dangerous to life. 

Any operations with the device which are not mentioned in these instructions, especially the 

removal of the housing and manipulation with the electric parts of the microscope, may be 

carried out only by an authorized person. It is also forbidden to substitute a part of the 

microscope for any other part that is not original and is not delivered by the microscope 

producer (e.g. the substitution of the original steel blinds on the flanges of the microscope 

chamber for light alloy blinds can cause an emission of dangerous ionizing radiation!) 

The microscope is provided with a number of automatic protections making unsuitable use 

impossible (e.g., it is not possible to switch on high voltage sources if the specimen chamber 

or electron gun space are open or are not evacuated to the working vacuum). The 

deactivation of these protections can cause destruction of the machine and endanger of the 

health of the operating staff. 

The symbols used meet the regulation standard ČSN EN 61010-1, except the symbol 

 

, marking the connectors with high voltage that are not dangerous in aspect of the mentioned 

regulation standard (accidental touch can only cause electrical shock). 

 

In the documentation there will two type of additional information given: Notes and 

Warnings, 

Notes are designated thus:  Note:  

In Italics and Blue print.  

Warnings are designated thus:  WARNING: 

In Italics and Red print. 
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3 Installation and Microscope Repairs 

3.1 Transport and Storage 

The method of delivery is defined in the contract and it is determined individually according      

to the destination. The method of delivery must be approved by the manufacturer. The 

instrument is delivered partially disassembled and packed. The purchaser is obliged to check 

the status of the boxes after handover by the delivery company. In the case of any damage it 

is necessary to catalogue the damage and inform the manufacturer of the situation. The 

packed instrument must be stored in a dry and clean place with a temperature range from       

-20°C to +40°C and must not be exposed to corrosive substances which can cause             

oxidation (acid vapours etc.). 

3.2 Installation Instructions 

The microscope is delivered including installation. Installation must be ordered from the 

seller. The customer shall inform the seller of the readiness of the laboratory for the 

installation. Once the laboratory is ready, technicians of the manufacturer or technicians 

of an approved company will carry out the installation, connection to the mains and user 

training. The customer is not allowed to connect the microscope to the mains or do any 

other manipulation, except moving the microscope to the storage place. The installation 

company will fill in the installation protocol. The warranty period will start from this date and 

the user can start using the instrument normally as described in this manual.  

3.3 Fuse Replacement 

The instrument does not contain any fuses which can be replaced by the user. All fuses are 

located under the covers, which can be removed only by a service technician from the 

manufacturer or a service technician of an approved company. The fuses can be replaced 

only by exactly the same type; the type is described in the documentation or on the fuse 

holder.  

3.4 Instrument Repair and the Spare Parts Usage 

It is only permited to use original spare parts delivered by the manufacturer. Repair and 

maintenance which exceed the procedures mentioned in this manual can be performed only 

by the manufacturer’s service technician or a service technician from an approved company.  



Description of the Microscope 

6 

MIRA 3 FEG-SEM 

4 Description of the Microscope 

4.1 Electron Column 

The scanning electron microscope displays the examined object by means of a thin electron 

probe. The column forms the electron probe (beam) and sweeps the beam over the 

examined specimen located in the microscope chamber. Most imaging qualities of the 

microscope depend on the parameters of this electron beam: spot size, aperture angle and 

beam intensity. 

The spot size determines the resolution of the microscope as well as usable magnification 

at stable picture sharpness. It is mainly considered that the spot is circular and has 

a Gaussian intensity profile. We can specify its size for example with half the width of the 

intensity distribution. The spot size is determined by the demagnification of the primary 

electron source, optical aberrations of the final lens (objective) and the diffraction aberration 

on the final aperture. The spot size is smaller at shorter working distances. 

The incident electron beam is cone-shaped. The vertex angle of the cone is determined      

by the aperture angle. The wider the cone, the lower the depth of focus.  

The beam intensity (BI) is determined by the number of electrons passing through the probe 

in a defined time. The image noise of the electron microscope depends on the number 

of electrons used for the information collected from each picture element. It is necessary 

to use more time for image scanning at low beam intensity and vice versa. 

It is evident that the incident beam parameters influence each other. The optical system       

of the microscope allows operation in different modes when some parameters of the beam 

can be preferred and the others can be kept down. Here are some typical examples: 

 Work on high magnification. It is necessary to reach a high resolution; therefore a low 

beam intensity, short working distance and slow scanning speed should be used. We 

recommend using the RESOLUTION mode, working distance not more then 7 mm and 

scanning speed 7 or slower. See chapter 4.1.1. 

 Work with high intensity. Resolution is small and useful magnification is low but fast 

scanning can be used because the signal to noise ratio is better. In any mode, use the 

function BI. The higher the BI index, the higher the beam intensity (the current 

of electrons in the beam). The exact value of the intensity can be set by function BI 

continually. 

 Work with high depth of focus. The aperture angle must be small. Use the Depth 

mode.  

The column of the microscope MIRA 3 consists of the following main parts: 

 The electron gun is the source of accelerated electrons. It consists of a suppressor, 

an extractor and an anode. The filament tip is connected to the negative electric 

potential while the anode is on zero potential. The filament tip is made of a tungsten 

wire with about 0.5 µm radius sharp peak. The filament tip is fixed to the tungsten 

wire heated to a temperature of 1800 K. Electrons are emitted by the tunneling 

through the surface barrier with contribution of the strong electrostatic field with 

an intensity of 108 V/m (Schottky effect).  
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The tip’s high temperature helps to prevent contamination of the tip and together 

with an atomic layer of the ZrO on the surface helps improve conditions for electron 

emission. The extractor ensures a high electrostatic field on the filament tip. It is 

located right in front of the filament tip and it has a positive voltage potential          

of several kilovolts (extracting voltage).    

 

The MIRA 3 cross section and schematic representation of the optical elements: 

 

The electron flow from the gun is specified by the emission current, which depends 

on the extracting voltage. Electron emission from the side of the filament is 

suppressed by the suppressor, which is located right behind the filament tip. The 

suppressor potential is several hundreds volts lower than the filament tip potential. 

The accelerating voltage between the cathode and the anode determines the overall 

energy of the electrons.  

The whole system behaves as an electron virtual source located in the region of the 

end of the tip with a characteristic size of approximately 20 nm, energy of the 

electrons in the range of 200 eV to 30 keV, emission current up to 300 µA and solid 

angle from 0.2 mA/srad to 0.35 mA/srad. 
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 The condenser C1 is a strong magnetic lens which controls the amount of electrons 

passing through the aperture diaphragm. The higher the condenser excitation, the 

shorter the focal distance and thus the beam cross-over is further from the aperture 

diaphragm. By moving the cross-over towards the aperture diaphragm the beam 

current becomes higher. The condenser current and thus its focal length can be 

controlled  by means of preset BI (Beam Intensity, BI 1 - BI 20) steps, or by entering 

the direct beam current value (BI Continual) or by the spot size value (Spot Size) 

which is strictly related to the beam current. 

 The gun centering is formed by a system of electromagnetic deflection coils under 

the gun. It is intended for tilting the electron beam emitted from the gun, so that it 

enters the axis of the optical system of the column. It is controlled by the function 

Gun Tilt. The gun can be centered optimally by the automatic function which can be 

activated by the button "Adjustment >>> /Auto gun centering". 

 The fixed aperture diaphragm trims the final displaying beam. It is located under the 

condenser and gun centering coils. The size of the diaphragm is chosen according 

to the optimal aperture angle of the electron beam and determines the maximum 

resolution ability of the column. 

 The auxiliary IML lens is a magnetic lens used for the aperture change of the beam 

entering the objective lens or for beam displaying if the objective lens is off. The 

change of the IML excitation causes a shifting of the electron beam across the optical 

axis and it is therefore necessary to compensate this shifting by means of the 

centering coils IML Centering. 

 The stigmator is an electromagnetic with an octupole design. It is intended for 

compensation of astigmatism in all the modes. 

 The scanning coils are formed by two stages of the deflection coils. A scanning ramp 

is connected to the coils. The ramp frequency determines the scanning speed of the 

electron beam; the amplitude determines the microscope's field of view and the 

magnification.  

 The objective is the last magnetic lens of the column that forms the resulting 

electron beam. In the usual modes the excitation of the OBJ determines the working 

distance - the distance between the focused specimen surface and the lower 

objective pole piece. In the Mira 3 with In-Beam technology the lens is combined 

electrostatic-magnetic for further improvement in microscope performance. 
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4.1.1 Electron Column Displaying Modes 

RESOLUTION Mode 

This is the basic and most common displaying mode. The IML lens is switched off, the OBJ 

lens is excited and it focuses the final electron beam. 

 

 

 

 

Characteristic:  

 high resolution 

 low depth of focus 

The MIRA 3 works like the other common three lens microscopes 

without IML in this mode. The aperture is nearly optimal for lower 

BI values (small spot size, low beam current) short working 

distances (4 - 5 mm) and for the accelerating voltage 30 kV. The 

pivot point of the scanning and the electric image shifts are close 

to the principal plane of the objective OBJ so that the curvature     

of the field, distortion and field of view are as good as possible. 

The centering of the objective OBJ is performed by defined beam 

tilt of the central electron beam, which does not cause image shift. 

This mode is intended for displaying with the highest resolution.  
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DEPTH Mode 

The DEPTH mode differs from the previous mode by the auxiliary lens IML being switched 

on. 

 

 

 

 

Characteristic:  

 good resolution 

 increased depth of focus 

 

The aperture of the final beam is lower, but the spot size is bigger 

in comparison with the RESOLUTION mode. The beam in the probe 

stays unchanged. This mode is used if it is necessary to have 

a greater depth of focus.  
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FIELD Mode 

The FIELD mode utilizes the intermediate lens IML for the electron beam focusing while the 

objective OBJ is off. 

 

 

 

 

Characteristic:  

 large field of view 

 high depth of focus 

 worse resolution 

The beam aperture is very small and the depth of focus is usually 

higher than the field of view. As the objective OBJ is off in this case, 

it does not affect the middle beam and thus does not need to pass 

near the centre of the objective OBJ. The position of the pivot point 

of scanning is optimized according to the field of view. The 

centering coils IML center the supplemental intermediate lens IML    

to avoid image movement during focusing. The DC component      

of the scanning coils is set up so that no image shift occurs 

if switched from the RESOLUTION mode to the FIELD mode. 

 

The disadvantage of this mode is bigger spot size; the maximum 

magnification used is a few thousand. The mode is used for the 

searching of the parts of the specimen to be examined.  
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WIDE FIELD Mode 

The WIDE FIELD mode uses the intermediate lens IML for focusing the electron beam, while 

the objective OBJ is excited to a high value. 

 

 

 

 

Characteristics:  

 extra large field of view 

 image distortion is corrected and minimized 

 only available for post-2007 devices 

 

Highly excited objective multiplies the deflection of the beam. The 

aperture of the beam is very small and the depth of focus is very 

high. The IML Centering coil serves for minimizing the image shift 

when focusing. 

 

The mode is used for to search for the part of the specimen to be 

examined. To know the proper magnification value, the objective 

must be well focused. This might be a little difficult due to the high 

depth of focus.  
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CHANNELING Mode 

In the CHANNELING mode, the scanning and lens focusing is controlled so that the electron 

beam touches the same point of the specimen surface all the time. By means of scanning the 

beam, only the angle of incidence of the electron beam is changed. 

 

 

 

 

Characteristic:  

 the position of the specified point in the image depends    

on the beam tilt 

 it is the mode for ECP acquisition - Electron Channeling 

Pattern 

 

The resulting image is the amount of electrons dependent on the 

impacting beam angle. The excitation ratio of the scanning coils is 

set up so that the beam utilizes the whole area of the objective lens 

bore and enters the lens parallel to the optical axis.  

All electron beams parallel to the optic axis are focused by the lens 

into a single point on the specimen surface. As a consequence, the 

scanning is transformed into beam tilting, i.e. the resulting pivot 

point of the scanning lies on the specimen surface plane.  

The intermediate lens focuses the beam into the upper focal point 

of the objective lens. The result is that the beam, after its passing 

through the objective lens, is parallel and the angular resolution    

of ECP (Electron Channeling Pattern) images is at its maximum. 

 

The mode is intended for the examination of crystallographic 

materials. In consideration of the optical abilities of the MIRA 3 

column, the minimum size of crystals is 100 - 150 µm. 

 

Note: ECP patterns are produced by back scattered electrons, it is preferable to use BSE 

detector for imaging if available.  



Description of the Microscope 

14 

MIRA 3 FEG-SEM 

4.1.2 Electron Column Centering 

To reach high quality images it is necessary to center the electron optics of the column. The 

centering is electronic and fully controlled by the PC. 

Each microscope is factory centered and this setup is stored in the Default configuration. By 

using the function Load default configuration from the menu Options -> Configurations ► 

the user will save time in the case he gets lost, loses his configuration completely etc. This 

default configuration file is also used when a new user is created as his initial configuration. 

There is factory preset for four accelerating voltages, one for each HV index. Switching 

among them the MiraTC software remembers all settings so the user does not need to make 

any further adjustments. However, changing the voltage within single HV index requires 

performing centering of the microscope: 

1. centering of the gun (see chapter 4.1.2.1) ; 

2. centering of the column, either automatic (see chapter 4.1.2.2) or manual (see 

chapter 4.1.2.3) for work on high magnifications. 

Note: Every user can save his own configurations in menu Options -> Configurations ►. Save 

as. Using of various configurations can save user’s time when switching between various 

voltages within the same HV index. 

 

Recommended centering conditions 

The centering is always performed by means of a special centering specimen, which is 

included in the microscope accessories and is marked as ADJ. The surface of this specimen 

has a fine structure, making the centering easier. If this specimen is not available, it is 

possible to use a common specimen stub. Once you start centering, the image must be 

focused perfectly. 

 

Mode Working Distance (WD) Beam Intensity  (BI) 
Magnification 

(Mag) 

Resolution 
actual WD on what you want to 

acquire images 

actual BI on what you want to 

acquire images 
2000 - 5000 x 

Depth actual WD actual BI 2000 x 

Field actual WD actual BI 500 x 

Wide Field actual WD actual BI max. Mag 
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4.1.2.1 Centering of the Electron Gun 

The centering is performed by automatic procedure. It is always necessary to perform this 

auto centering after the high voltage value changes inside a specified range with the item 

High Voltage on the Pad panel.  

1. Insert the centering specimen. 

2. Set up the recommended working conditions. 

3. Use the function Adjustment >>> Auto gun centering in the Electron Beam panel 

(see Figure 16). 

4.1.2.2 Automatic Centering 

The automatic procedure of column centering is very fast and suitable for low magnifica-

tions. For very precise work at high magnifications the manual centering is more suitable. 

1. Insert the centering specimen. 

2. Set up the recommended working conditions and focus the image in RESOLUTION 

mode. 

3. Use the function Adjustment >>> Auto column centering in the Electron Beam panel. 

 

 

 

4.1.2.3 Manual Centering 

1. Insert the centering specimen. 

2. Set up the recommended working conditions and focus the image in RESOLUTION 

mode.  

Note: Manual centering is for experienced users. 

Note: In case of MIRA 3 with InBeam detector check the item InBeam mode in the SEM menu. 

3. Use the Adjustment >>> Manual column centering function in the Electron Beam 

panel. The image starts wobbling that is, periodically changing the working distance. 

Press the Next>> button.  

4. Minimize the image movement by changing the OBJ Centering (select in the Pad 

panel) using the trackball and keys F11 and F12. Press the Finish button. 

It might also be necessary to have FIELD or DEPTH modes precisely centered if working 

on higher magnifications. If needed proceed with the following steps: 
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5. Switch to FIELD mode. Set the same magnification for RESOLUTION and FIELD modes. 

Use the Adjustment >>> Manual column centering function in the Electron Beam 

panel. Minimize the image movement by changing the IML Centering (select in the 

Pad panel) using the trackball and the F11 and F12 keys. Set the same field of view 

by changing the OBJ Centering using the trackball and the F11 and F12 keys.  

6. Switch to DEPTH mode. Use again the procedure with Manual column centering and 

OBJ Centering (steps 3. and 4.). 

7. Switch to WIDE FIELD mode and set the same magnification for RESOLUTION and 

FIELD modes. Use again the procedure with Manual column centering and OBJ 

Centering. 

MIRA 3 with InBeam detector: 

It is recommended to work with enabled InBeam mode all the time. However, there is the 

possibility to use purely magnetic objective lens. Proceed with following: 

1. Uncheck the item InBeam mode in the SEM menu. 

2. Select the SE detector on the Detectors & Mixer panel.  

3. Switch to RESOLUTION mode and center the mode as usual. Ensure that the image is 

correctly stigmated; especially at low beam voltages (it is applicable also for other 

modes). 

Note: RESOLUTION mode is the basic and most common displaying mode. The procedure 

described above is sufficient for working in Resolution mode on high magnifications. 

It might also be necessary to have FIELD or DEPTH modes precisely centered if working 

on higher magnifications. If needed proceed as follows: 

1. Switch to DEPTH mode and centre this mode as usual.  

2. Switch to FIELD mode and only set the same field of view by changing the OBJ 

Centering.  

3. Switch to WIDE FIELD mode and center this mode as usual. 

Note: If you want to align field of view for DEPTH mode exactly with RESOLUTION mode (for 

magnifications > ~10000), set the same magnification in RESOLUTION and DEPTH modes 

and then set the same field of view by means of changing the IML Centering parameter.  

WARNING: This procedure has a strong influence on the other centering parameters and thus 

is recommended only for experienced user. 

4.1.2.4 Electron Column Precentering 

The column is factory precentered. It is also precentered after every filament exchange 

by the service technician. Further precentering can be performed only by an expert level 

user. This can be an advantage at lower accelerating voltages (HV < 5 kV). On the other 

hand, incorrect precentering can cause a situation where the objective and stigmators cannot 

be corrected at all. 
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There are four HV indexes, which should be precentered with care: 

HV index The range of beam voltage [kV] The beam voltage for centering [kV] 

1 0.2-3 2 

2 3-7 5 

3 7-15 10 

4 15-30 20 

Instructions:  

1. Set the HV index and the correct HV for precentering according to the preceding 

table and change the scanning mode to RESOLUTION. Set the values of Stigmators, 

IML centering and OBJ centering in the Pad panel to 0 %. 

2. Focus the image on the centering sample at magnification >> 1kx (for example 4kx). 

3. Use Manual column centering and check the option "Use OBJ Precentering". 

4. Minimize the image movement by the OBJ Precentering. 

5. Switch to FIELD mode and center this mode (follow the wizard). 

6. Switch to RESOLUTION mode, focus and centre the mode as usual (not checking the 

option OBJ Precentering). 

7. Center the stigmators: use the Stigmator A/B Centering function in the main menu 

SEM and follow the wizard for Stigmator A and Stigmator B (use trackball).  

8. Switch to DEPTH mode, focus and centre this mode (follow the wizard).  

9. Switch to WIDE FIELD mode and centre this mode (follow the wizard). 

10. Repeat steps from 1. to 9. for each of four HV indices.  

Note: In case of MIRA 3 InBeam detector, check the item InBeam mode in the SEM menu. 

MIRA 3 with InBeam detector: 

1. Uncheck the item InBeam mode in the SEM menu. 

2. Select the SE detector on the Detectors & Mixer panel. 

3. Switch to RESOLUTION mode and centre this mode as usual. 

4. Switch to DEPTH mode and centre this mode as usual.  

5. Switch to FIELD mode and only set the same field of view by changing the OBJ 

Centering.  

6. Switch to WIDE FIELD mode and center this mode as usual. 

7. Repeat steps from 3. to 6. for each of four HV indexes. 
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4.2 Chamber and Sample Stage 

The chamber is a sealed space under the column for placing your specimen for investigation. 

The specimen is fixed on the sample stage, thus allowing you to move your sample during 

the investigation process. The chamber must be evacuated during investigation. 

The sample stages are divided into two basic types:  

 motorized 

 manual 

Manipulators have electrically isolated specimen holders. The specimen holder is connected 

to pA-meter. The pA-meter also works as an acoustic contact indicator of the specimen      

to the chamber. If contact between the specimen holder and the chamber body occurs, all 

motorized axes will stop and an audible sound will indicate the contact. 

The chamber and sample stage types 

Type Motorized axes Manual axes Eucentricity 

LM X, Y, Z, Rotation, Tilt - automatic 

XM X, Y, Z, Rotation, Tilt - automatic 

GMH X, Y, Z, Rotation, Tilt - automatic 

GMU X, Y, Z, Rotation, Tilt - automatic 

The eucentric position is such a position of the specimen, where the observed area of the 

sample does not move when tilting the sample itself. The auto-eucentric function can be 

activated by checking the Keep View Field box on the Stage Control panel in the MiraTC 

software. 
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5 Vacuum Modes 

The microscope allows the investigation of specimens in a pressure range of 0.005 Pa 

to 150 Pa.  

Mode Pressure [Pa] Microscope type Note 

high vacuum 0.005 
LMH, XMH, GMH 

LMU, XMU, GMU 

 

 

low vacuum 7 - 150 LMU, XMU, GMU 
aperture in the 

objective 

There is a differential pumping aperture in the objective. Sample observation is possible with 

chamber pressure up to 150 Pa. 

5.1 High Vacuum Mode 

In high vacuum mode, it is possible to investigate both conductive and non-conductive 

samples; however non-conductive samples require previous metal coating (Cr, Au, Au-Pd, 

Pt). All displaying modes are available. 

5.2 Low Vacuum Mode 

The low vacuum mode is intended for the investigation of non-conductive samples. 

1. Vent the microscope and insert the aperture into the objective (see chapter 9.2). 

2. Switch the microscope to Low vacuum mode (pressure range 1 - 150 Pa) using the 

UniVac button on the Low Vacuum Mode panel. 

3. Enter the chamber pressure in the Vacuum panel. 

4. Pump the microscope. 

5. Enter the requested pressure value in the field next to the UniVac button and click 

on the OK button. 

6. Only RESOLUTION and DEPTH modes are allowed to be used. 

7. To return to the high vacuum mode, click on the UniVac button, vent the microscope 

and remove the final aperture from the objective. 

file:///C:/ABCTemp/mira/k330.htm
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6 Detectors 

The detection system may contain a set of detectors designed for detecting various signals 

resulting from electron beam interaction with the sample surface. The microscope is always 

delivered with the SE detector. 

Switching on 

 In the case of adjustment of the required detector, select the appropriate one from 

the list box in the Detectors & Mixer panel (see Figure 4). This procedure is valid for 

all detectors except the LVSTD, where further procedures are needed (see chapter 

6.3). In the case of the InBeam detector, check the item InBeam mode in the SEM 

menu first. 

6.1 SE Detector  

The detector works in high vacuum only. 

Secondary electrons enhance topographic contrast as opposed to material contrast of back-

scattered electrons. The secondary electron (SE) detector is a basic standard detector always 

present in the microscope.  

The SE detector is of an Everhart-Thornley type. The grid on the front part of the detector 

has positive potential. This attracts and accelerates the low-energy secondary electrons 

arising on the specimen surface and focuses them onto the scintillator. The light flashes, 

which result from the impingement of the electrons on the scintillator, are transferred 

through the light guide to the photo-multiplier outside the chamber of the microscope. 

6.2 In-Beam SE Detector 

The detector works in high vacuum only. 

The so-called In-Beam detector is located in the objective lens and detects secondary 

electrons. It attracts electrons emanating from the sample surface into the objective lens and 

catches them there. This type of detection is sometimes called “in-lens“ or “through-the-

lens“  in the literature. 

This allows for the observation of specimens at very short working distances (WD) and thus 

with improved resolution. The standard SE detector at a short WD would not have a good 

signal because the path of secondary electrons from the specimen to the standard SE 

detector would be shielded by the column. Moreover, the combined electrostatic-magnetic 

lens gives further improvement of microscope performance. 

In-Beam technology works in its own mode of the column (the item Enable InBeam mode 

in the SEM menu is checked). Therefore, objective centering and stigmator parameters are 

different from the condition of disabled InBeam mode. The software automatically 

remembers the set of parameters when switching between these two. All optical modes are 

available in the In-Beam regime (Resolution, Field, Depth, Wide Field, and Channeling) and 

all detectors may be used (InBeam, SE, BSE and others). We recommend working with the 

InBeam mode enabled all the time. 
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Images taken by the SE detector and the In-Beam detector may differ because the In-Beam 

detector observes a specimen from the top whereas the SE detector from the side. The 

resolution is better at a short WD using the In-Beam detector. The signal also varies with 

WD. It is generally recommended preferring the In-Beam detector at a WD shorter than about 

5 mm and the standard SE detector at a WD longer than 5 mm. At a short WD be very careful 

not to hit the objective with the specimen. 

6.3 LVSTD Detector  

The detector works in low vacuum only. 

The LVSTD detector (Low Vacuum Secondary Tescan Detector) is a detector of secondary 

electrons, specially designed for low vacuum mode. It is suitable for the investigation 

of non-conductive samples. 

The LVSTD consists of a standard Everhart-Thornley detector situated in a separated 

detector chamber. This detector chamber is pumped by a small turbo molecular pump.  

 

 

 

Switching on 

1. Check that the UniVac mode is switched on and check that the required value of the 

pressure in the chamber has been set lower than ~150 Pa.  

2. To switch on the detector click on the LVSTD button on the Low Vacuum Mode panel 

(see Figure 13). 

3. Now the detector chamber is automatically pumped down. This may take about              

2 minutes. The blinking message "LVSTD detector not ready yet" appears in the 

panel. Wait until this message disappears.  

4. In the Detectors & Mixer panel select LVSTD detector from the list box (Figure 4). 

 

Switching off 

The detector can be switched off by simply clicking on the LVSTD button on the Low Vacuum 

Mode panel. 
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The detector is automatically switched off: 

 if the pressure in the chamber exceeds value higher than 150 Pa. 

 if the UniVac mode is switched off. 

The detector needs to be switched on manually if automatic detector switch-off occurs.  

Note: The stability of the signal from the LVSTD depends strongly on the pressure inside the 

chamber. In order to obtain an image with stable brightness, it is necessary to have stable 

pressure in the chamber. Therefore, after a change of the required pressure value, it might 

be necessary to wait a while until the pressure reaches the new level and becomes stable.  

Note: The secondary electrons, in contrast with backscattered electrons, are much more 

sensitive to specimen surface charging, as they are of very low energy. There are several 

ways how to eliminate charging: using a higher pressure in the chamber, using a lower 

accelerating voltage of primary electrons or using lower electron beam current.  

6.4 BSE Detector  

The detector works in both high and low vacuum. 

Back-scattered electrons (BSE) enhance material contrast of the sample. The BSE detector is 

of the scintillation type. An annular (YAG) mono-crystal scintillator with a conductive surface 

is placed in the optical axis directly under the lower pole extension of the objective. The high 

energy back-scattered electrons impinge the scintillator without any additional acceleration 

and excite the scintillator atoms that emit visible radiation photons successively. The 

photons are carried, by means of the light guide, through the side outlet of the scintillator      

to the cathode of the photo-multiplier. They are then processed in the same way as the 

signal coming from the secondary electrons.  

The BSE detector is manufactured in an R-BSE (Retractable BSE) version. This modification 

allows the retraction of the detector from under the pole piece position if the detector is not 

used. This allows the specimens to be moved as close as possible to the objective when 

viewed by other detectors. 

6.5 CL Detector 

The detector works in high as well as low vacuum. 

The cathodoluminescence detector is available in two versions depending on the wavelength 

range of the detected light: 350 – 650 nm range (mainly visible and near UV light) or 185 – 

850 nm range (UV, visible and near IR light). The first version is made either as a stand-

alone detector or exchange CL / BSE detector. 

The IR camera (Chamber View) must be switched off during operation of the CL detector. 

6.5.1 Exchange of CL for BSE Lightguide 

(Only available in exchange CL / BSE of 350 – 650 nm range version.) 

1. Retract the current detector fully (i.e. it is close to the chamber wall, not under the 

column). 
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2. Put on gloves and open the chamber. Rotate the light guide by hand around its axis 

by about 30 degrees. 

3. Move the current lightguide horizontally in the direction of its axis towards the 

objective until it is released. 

4. Insert the new lightguide in exactly the opposite way: rotated by about 30 degrees 

from its working position, move it in the direction of its axis horizontally towards the 

photomultiplier until the stop. 

5. Rotate the new lightguide by hand to its fixed position. 

6. Return the detector carefully to its working position using the retraction mechanism 

and observe whether the new lightguide sits well and does not hit the objective. 

 

6.6 Other Detectors 

TESCAN provides other special detectors, which can be attached to the microscope. It is 

possible to obtain the list from the manufacturer.  
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7 Control Elements 

7.1 Keyboard 

The keyboard is used for text and numeric input. Its usage does not differ from the system 

Windows practice.  

 

Keyboard shortcut Command 

Ctrl + O Open... 

Ctrl + S Save As... 

Ctrl + P Print... 

Alt + X Exit 

Ctrl + H View Header... 

Ctrl + C Copy to Clipboard... 

Ctrl + V Paste from Clipboard... 

Ctrl + Alt + PgUp Zoom All In 

Ctrl + Alt + PgDn Zoom All Out 

Ctrl + PgUp Zoom In 

Ctrl + PgDn Zoom Out 

F1 Help - Contents 

F11 hold down 
Blocks the changing of the right 

parameter of the active function. 

F12 hold down 
Blocks the changing of the left 

parameter of the active function. 
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7.2 Mouse 

The mouse usage follows the Windows system practice.  

Mouse functions during normal scanning: 

 Double-click with the left mouse button on the SEM Scanning window switches the 

Focus window on/off.  

 Turning the mouse wheel changes the scan speed (the SEM Scanning window needs 

to be active).  

 If the microscope is scanning over the whole SEM Scanning window, then 

o clicking the right mouse button opens the context menu for simple program 

control.  

 If the microscope is scanning only in the Focus window, then 

o holding down the right mouse button and dragging the mouse cursor in the 

SEM Scanning window changes the dimensions of the Focus window.  

o holding down the left mouse button and dragging the mouse cursor in the 

SEM Scanning window moves the Focus window.  

o double-clicking the right mouse button on the Focus window moves this 

window to the center of the image. 

o clicking the right mouse button out of the Focus window opens the context 

menu. 

 Clicking the mouse wheel on a selected object in the SEM Scanning window moves 

the stage so that the object lies in the center of the SEM Scanning window.  

 Holding down the mouse wheel on a selected object and dragging the cursor to any 

position in the SEM Scanning window moves the object to the selected position in the 

SEM Scanning window. 

 Holding down the mouse wheel on a selected object in the SEM Scanning window for 

longer than 0.8 seconds moves the stage so that the object lies in the centre of the 

SEM Scanning window and the magnification is increased by the factor set in the SEM 

-> Options -> Center Zoom. 

Note: If an additional software module is active, the functions of the buttons can be 

different.  
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7.3 Trackball 

The trackball is often used with the Pad panel. 

Turning the trackball in the direction of the axis X changes the first 

parameter of the active function; turning the trackball in the direction 

of the axis Y changes the second parameter of the active function. 

Holding the F11 key locks the first parameter of the active function; 

using the F12 key locks the second parameter of the active function.  

 

 

 

7.4 Control Panel 

The Control Panel has several knobs and colour touch screen. It was developed by TESCAN 

exclusively for SEM control. It is not a standard SEM part. 

The manual knob set provides the user with a simple and 

straightforward way of operating the microscope. It can control the 

stage, magnification, focus, beam intensity, scanning speed and 

other parameters.  

Most common functions have dedicated knobs. The three upper 

knobs have variable function; their actual function is shown at the 

bottom of the touch screen. Several important parameters are 

shown in the middle of the display. There are also shortcuts to the 

automatic functions (focus, brightness/contrast, image acquisition) 

in the header. 
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8 Getting Started 

Note: Prior to using the MIRA 3 FEG the user should read this entire chapter and be familiar 

with all the information contained herein. 

8.1 Microscope Starting  

A desktop icon  serves for starting the MiraTC software. To log in, a user name and 

password are required. Each user has his own profile.  

The field emission electron gun is permanently switched on, unless a non-standard situation 

occurs (long term power supply interruption, servicing of the microscope, etc.). This ensures 

stability of electron emission without interruption for the whole lifetime of the Schottky 

cathode (several thousand hours). 

Monitoring of the gun emission conditions runs in the background of the software and hence 

the gun can be switched off safely in the case of a mains power failure. Therefore, the 

MiraTC software should be permanently running. In the case that the software is completely 

switched off (computer restart for example), it is necessary to start the software.   

1. Click on the MiraTC icon  on the Windows desktop. The MiraTC - Log in screen 

is displayed with prompt for user name and password. 

2. In the case that the microscope is in Standby mode (see Figure 1), click on the 

STANDBY button on the Vacuum panel to initialize the microscope. Start the pumping 

procedure using the PUMP button (Figure 2). It takes usually around 3 minutes 

to reach vacuum ready – status, meaning that microscope is ready to use. If there is 

a need to exchange the specimen, follow instructions in chapter 8.2. 

3. Load the default configuration using Configuration ► Load Default Configuration 

function from the Options menu. 

Figure 1 

  

Figure 2 
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8.2 Specimen Exchange 

The specimen should somehow be fixed or glued to the specimen stub, before it is inserted 

into the chamber. It is possible to use 12.5 mm specimen stubs or any other specimen 

holders, delivered as microscope accessories. 

If the specimen is examined in the high vacuum mode, it should be conductive or should be 

made conductive using one of the methods described in the technical information. The 

conductive surface of the specimen must be conductive contacted to the stub. 

Non-conductive samples can be examined in the low vacuum mode. 

1. Vent the microscope by using the VENT button on the Vacuum panel. Wait until the 

pressure is at atmospheric level. 

2. Open the chamber door by gently pulling it. 

3. The automatic positions set up in the Stage Control panel can be used, which are 

intended for the specimen position exchange. To select the sample position click    

on the appropriate number button on the carousel. At this time the button 

background is red to indicate the specimen exchange mode.  

WARNING: If the specimen stage is moving, do not touch any of its parts. The moving 

manipulator can cause health injuries. During the changing of the specimen use the 

suitable gloves for prevention of pollution of inner microscope parts. 

4. Loosen the screw holding the specimen stub on the specimen stage. Remove the 

specimen stub by lifting the stub upwards. It is recommended that suitable tweezers 

be used (Figure 3). 

5. Use the previous steps in reverse order to place the new specimen in position. Once 

the specimen stub is fastened with the specimen, make sure that it will not touch any 

interior part of the chamber. Contact between the specimen and the chamber will be 

indicated by an acoustic buzzer. 

WARNING: Collision of the specimen with any of the parts of the chamber interior can 

cause damage to the microscope. 

Figure 3 

   

file:///C:/Users/Tescan/AppData/ABCTemp/mira/Panels_HVvac.htm
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Note: Contact between the specimen and any part of the chamber is indicated                

by  a special electric circuit. This circuit is based on the measuring the electric current. 

It works only if the specimen is conductive.  

6. Close the chamber door by pushing it towards the chamber. 

7. Start the pumping procedure by clicking on the PUMP button on the Vacuum panel, 

where the actual pressure and pumping progress are also displayed. Ensure that the 

chamber door is tightly closed. 

8.3 Images at Low Magnification  

There are four factory presets for the accelerating voltage (2, 5, 10, 20 kV), one for each HV 

index. The user does not need to perform any further adjustments by switching between 

them and using magnification up to 4000x. 

1. In the SEM Detectors & Mixer panel select the appropriate detector from the list box 

(Figure 4). Using the SE or BSE detector is recommended. When the BSE detector is 

used, ensure that the detector is not retracted! See chapter 6 for detailed 

information.  

Figure 4 

 

Note: Notice the difference between SE and BSE images below (Figure 5).  

Figure 5 

    

 

SE Detector BSE Detector 
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2. Select the accelerating voltage (20 kV recommended) using combo box on the 

Electron Beam panel (Figure 6).  

Figure 6 

 

3. Clicking on the BEAM ON button on the Electron Beam panel turns the electron beam 

on (Figure 7).  

Figure 7 

                                                              

4. Right-click in the SEM Scanning window to open menu and select the Minimum 

Magnification function (Figure 8).  

Figure 8 

 

5. Right-click in the SEM Scanning window to select the Auto signal function to set 

brightness and contrast (Figure 8). 

6. Clicking on the WD icon  on the Toolbar and turning the Trackball from left        

to right (or vice versa) focuses the image (alternatively use the Auto WD function for 

focusing (Figure 8)). Double-clicking in the SEM Scanning window opens the Focus 

window. To remove the Focus window double-click anywhere in the SEM Scanning 

window. 

7. Focus in the Resolution mode (click on the Scan Mode function in the Info Panel and 

select RESOLUTION). 
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8. To select beam intensity (BI 10 recommended), first left-click on the BI icon        

on the Toolbar and then use arrows on the Pad panel (Figure 9).   

Figure 9 

 

 

9. To select the sample position on the Stage Control panel, click on appropriate 

number button on the carousel (Figure 10). 

Figure 10 
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10. Placing the cursor over the SEM Scanning window and clicking the mouse wheel move 

that area on the stage into the centre of the image. See chapter 7.2 for other mouse 

actions. 

11. To magnify the image click on the Magnification icon  on the Toolbar and turn 

the Trackball from left to right. 

12. Once the area of interest is magnified and focused as desired, right-click on the 

Speed icon  on the Toolbar and select appropriate scanning speed.   

13. Clicking on the Acquire button on the Info Panel (Figure 11) or on the icon   

on the Toolbar saves the image. Fill in the note, sign and description field 

if necessary. Choose a folder in which to store the image. To change the parameters 

of the image use the Image Parameters function in the SEM menu.   

14. Clicking on the icon  opens the dialog for saving the actual adjustment of the 

microscope. It is possible to restore the saved adjustment of the microscope later. 

Figure 11 

 

8.4 Imaging in Low Vacuum Mode 

An ordinary SE detector is not available in the low vacuum operations (see chapter 6), 

therefore Tescan have developed the LVSTD detector that gives topographical information 

from the sample in low vacuum. The BSE detector is available for both modes (LowVac, 

HiVac) and gives compositional information. 

1. Insert the final aperture into the objective according to the instructions in chapter 9.2 

or in the help file in the MiraTC software.  

2. Switch the microscope to the Low vacuum mode (pressure range 1 - 150 Pa) using 

the UniVac button on the Low Vacuum Mode panel (Figure 12).  
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3. Enter the desired pressure value in the field next to the UniVac button and click 

on the OK button. 

Figure 12 

 

Figure 13 

 
 

4. If LVSTD is attached to the chamber, there is the LVSTD button present (Figure 13). 

5. To switch between detectors use the Detectors & Mixer panel and select the 

appropriate detector (BSE or LVSTD) from the list box (see Figure 4).  

6. Turn on electron beam by clicking on the BEAM ON button on the Electron Beam 

panel (Figure 7).  

7. Set minimum magnification.  

8. To select beam intensity (BI 10 recommended), first left-click on the BI icon        

on the Toolbar and then use arrows on the Pad panel (Figure 9).   

9. Use the Auto Signal function to set suitable brightness and contrast. 
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10. Select the OBJ Centering function from the combo box on the Pad panel (Figure 14) 

and turn the Trackball to set the brightest area into the centre of the SEM Scanning 

window. 

Figure 14 

 

11.  Follow the instructions 9. – 14. in chapter 8.3. 

Note: Some non-conductive samples, which are not too sensitive to the beam, can be 

handled at lower voltages in the high vacuum mode. Different high voltages can be selected 

from the Electron beam panel. 

Note: See LVSTD images obtained at low vacuum mode of organic sample without coating 

(Figure 15).   

Figure 15 

     

 

8.5 Images at High Magnification 

1. Insert an appropriate sample for high magnification images (e.g., tin on carbon 

sample, (Figure 20). 

2. The best resolution is achieved at the highest accelerating voltage (30 kV) of the 

primary electrons. Select the fourth HV index using the combo box on the Electron 

beam panel (15 - 30 kV). Select the High voltage function from the combo box on the 

Pad panel or click on HV in the Info Panel. Type value 30 kV into the Pad panel. 

3. Turn on the electron beam.  
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4. Select the Auto gun centering function using the combo box on the Electron beam 

panel after clicking on the Adjustment button (Figure 16). 

5. Focus in the Resolution mode (click on the Scan Mode function in the Info Panel and 

select RESOLUTION or use the Continual Wide Field option – switches automatically 

between Wide Field and Resolution Mode and vice versa when increasing 

or decreasing magnification). 

6. For the best resolution, it is necessary to work at a short working distance (WD). The 

optimum WD is about 5 mm for the SE detector and 1 - 2 mm for the InBeam detector 

(in the case that the BSE is not mounted underneath the objective lens). For BSE 

images the optimum WD is about 8.5 mm. To change the working distance together 

with Z axis without defocusing the image use the WD&Z function on the Stage 

Control panel (Figure 17).  

Figure 16 

 

Note: Before changing WD&Z or WD use the degauss function by means of the  icon. 

The image should remain in focus. 

Figure 17 

 

7. Gradually magnify and focus the image to achieve 10kx magnification. In the case 

that the image is moving during focusing, it is necessary to check the centering 

of the objective. Select the Manual column centering function using combo box 

on the Electron beam panel after clicking on the Adjustment button (Figure 18). The 

Manual Centering Wizard window will appear (Figure 19). Clicking on the WOB button 

opens the Focus window in the SEM Scanning window. Click on the Next>> button 

to obtain the next instructions. The function of centering has two adjustable values. 

To be sure just one value is changing hold down the F12 key to change only X 

movement at the Trackball and the F11 key to change only Y movement. 
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Figure 18 

 
Figure 19 

                              

8. Each time that the image is too dark or light it is necessary to use the Auto Signal 

function (see Figure 8 or use the icon  ). To set the contrast and brightness 

manually, click on the icon  and use the Trackball. 

9. At higher magnifications (>10kx) it is necessary to check if astigmatism (Figure 

20 (a), (b)) is precisely corrected (Figure 20 (c)). To correct astigmatism click on the 

Stigmator function in the Info Panel (Figure 21). For precise correction use the Focus 

window (in the SEM Scanning window) and the F11 and F12 keys in the same way 

as in point 8.  

10. Select the appropriate scanning speed and save the image. 

   Figure 20 

   

(a)                  (b)                       (c) 
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Figure 21 

 

11. Clicking on the icon  open the dialog for saving the current adjustment of the 

microscope. It is possible to restore the saved adjustment of the microscope later. 

8.6 Microscope Stopping 

If it is necessary to interrupt work with the microscope for longer period of time, it is 

possible to switch the microscope to STANDBY mode. Part of the control electronics and the 

pumping of the chamber are off. The ultra vacuum electron gun is divided off the high 

vacuum by the valve so that the electron beam can not enter the chamber. 

Since the electronics are off, the column is not heated by the power dissipation of the 

magnetic coils, and the filament itself works in better vacuum conditions, thus extending the 

filament lifetime. The power consumption is approximately half in comparison to normal 

operation. When reinitializing the microscope (switch off the STANDBY mode) the 

temperature drift can cause lower time instability of the image on extremely high 

magnifications. It is thus recommended to use the STANDBY mode only in the case of long 

work interruption (at least overnight). 

It is also possible to switch on the pumping system in the STANDBY mode using the PUMP 

button and keep the chamber under minimal pressure. The disadvantage is a reduction 

in the lifetime of the pump and higher power consumption. 

1. The STANDBY mode is switched on by clicking on the button on the Vacuum panel. 

2. To keep the chamber pumping system on (it is switched off by default) switch it 

on by clicking on the PUMP button on the Vacuum panel. 

As well as the MiraTC control software, the gun continues to run all the time. After switching 

to the STANDBY mode, the user just logs off (File->Log off...). If the user wishes to use the 

system again, he can log on by entering his user name and password. The microscope then 

loads the settings of the user. 
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9 Microscope Maintenance 

9.1 Basic Microscope Accessories  

This document describes the use of the most important tools included in the microscope 

accessories. The exact list is attached to the packaging list of the microscope.  

 

 

 

1. Hexagonal screwdriver, size 3.0 mm – general use, mainly various flange screws, the 

most common size used for screws. 

2. Hexagonal screwdriver, size 2.5 mm – used for mounting / dismounting sample stage 

Z extensions (LS, LM chambers) and the stub holder (XM chamber). 

3. Flat screwdriver, size 3.2 mm – general use. 

4. Hexagonal screwdriver, size 1.5 mm – used for fixing the screws in the sample stage. 

5. Low vacuum aperture holder. 

6. Screw, size M3x25 – used for the removal of the low vacuum aperture holder. 

7. Basic specimen stubs. 

8. Flat tweezers – general use. 

9. Vacuum grease – used for sealing of the o-rings. 
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9.2 Insertion of the Final Aperture for the Low Vacuum Mode 

This aperture is inserted into the objective and it is accessible from the microscope chamber. 

 

1. Before inserting the aperture into the objective, move out the BSE detector. 

2. Open the chamber door and insert the aperture holder into the objective with the 

wider part down. 

3. To remove the aperture holder use the screw included in the microscope accessories. 

Place the screw in the aperture holder and by pulling down the screw, take out the 

aperture holder. 

The apertures become contaminated during microscope usage, which can cause a reduction 

in the optical qualities of the column. It is necessary to clean them from time to time 

or exchange them.  

9.3  Cleaning of the Final Aperture 

Contamination and impurities taken into the microscope appear during the exchange 

of specimens. They cause degradation of the optical qualities of the microscope. That is why 

it is necessary to clean aperture from time to time.  

The frequency and the method of cleaning depend on the operation conditions. Under 

normal conditions, cleaning the aperture every 3 - 6 months is recommended. 

The final aperture is made of platinum and therefore it needs special treatment. 

Recommended cleaning steps: 

1. Place the aperture into a beaker filled with isopropyl alcohol, ethanol or coleman fuel. 

Wash the aperture in the ultrasonic bath for about 10 minutes. 

2. Anneal the clean aperture in the alcohol burner. Use only clean ethanol for the burner 

to prevent the combustion products to polluting the aperture. 

3. Place the aperture into the aperture holder and blow the assembled holder with the 

aperture with clean compressed air or nitrogen. 
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9.4 Specimen Holders 

The specimen holders differ according to the type of microscope delivered, here is only 

an overview of the possible types.  

 

 

 

Standard specimen holder ø12.5 mm, height 

3 mm:  

the most common holder suitable for smaller 

specimen. The specimen is normally glued width 

conductive glue or stuck on with double-side 

sealing tape. 

 

Specimen holder GM163-A, ø14 mm, height 

20 mm:  

extension for small specimen holders for work 

at very short working distances. 

 

Specimen holder HM113: 

for small round-shaped samples up to a max. 

diameter of ø12 mm. 

 

Specimen holder HM116: 

for round-shaped samples up to a max. diameter 

of ø20 mm.  
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Specimen holder TE0038B:  

for standard ø30 mm samples.  

 

Specimen holder HM114: 

for flat samples up to the width of 20 mm. 

 

Specimen holder GM153: 

replacement of the standard seven-position 

specimen holder (the seven-position holder must 

be removed). Designed for rod shaped samples    

of diameter up to 26 mm.  

 

Specimen holder HM154-A:  

CAMSCAN ø12.5 mm specimen holder adaptor.  

 


